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Coursework for Faculty
You as a faculty member have been given full control  of the entire Coursework portlet, which allows you to design, build, track, and grade three types of assignments for
your students for each course that you teach:

Online ( )

File Exchange ( )

Offline ( )

Assignments,  whether organized by Unit or Type, are sorted by Due Date.  Each assignment listing includes the format (online, offline, file exchange), the due date, type,
and status.  Also, you can sort the assignments by clicking on any of the column headings.

You can create multiple units or use the one default  unit; however, every assignment must be part of a unit.  Units can be added, renamed, and reordered.  Units
(including their content) can be deleted, unless there is only one unit, in which case it cannot be deleted.  There must always be one unit present.

Assignments can be organized by Unit or Type, and the details and setup of the assignment are accessed by clicking the assignment name.  Information displayed
depends on the assignment type.

For Online assignments, you can use the Test Builder to create and maintain them.

Functions

Add Units
You must always have at least one unit.  The default  unit is Unit 1; however, you can rename the unit by editing it or deleting it after you have added an additional unit.  If
you retain the default  unit, you may want to add a description.

From the Coursework portlet:

1. Click the Add a Unit link.

2. Enter the name of the new unit and a description, and select the appropriate position (placement on the Coursework portlet).

3. Click the Save button.

4. Add additional units by repeating Steps 1-3 above.

Reorder Units
From the Coursework portlet:

1. Click the Reorder Units link.

2. Enter the appropriate position number in the text box beside the unit name.

3. This screen also allows you to edit a unit name (click the Edit icon) or delete a unit (click the Delete  icon).  Remember that if you delete a unit, you also
delete any assignments in that unit.

4. Click the Save button.

Edit Units
From the Coursework portlet:

1. Click the Edit icon beside the unit you want to edit.

2. Edit the unit name, description, and/or position.

3. Click the Save button.

Delete Units
From the Coursework portlet:

1. Click the Delete  icon beside the unit you want to delete.

2. The following message appears:  "Are you sure you want to delete this Unit?  Any assignments associated with the Unit will be permanently deleted."

3. Click OK to complete the delete process.

Manage Types

https://my.mineralarea.edu/ics/Help/LMS/default_1.htm
https://my.mineralarea.edu/ics/Help/LMS/coursework_portlet.htm
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Add a Type
Some default  types are available; however, you can add additional types.

From the Coursework portlet:

1. Click the Manage Types link.

2. Click the Add a Type link.

3. Enter the name of the new type.

4. Click the Save button.

5. Add additional types using Steps 1-4 above.

Edit a Type
From the Coursework portlet:

1. Click the Manage Types link.

2. Click the Edit icon beside the type you want to edit.

3. Edit the type name.

4. Click the Save button.

Delete a Type

You must always have at least one Type defined.  Therefore, if you have only one Type defined, you will not
be allowed to delete it.
NOTE:  If you delete a type to which an assignment belongs, that assignment will automatically be assigned to the type listed first alphabetically.  If the type being deleted
is the first type alphabetically, then the assignment will automatically be assigned to the type that is listed second alphabetically.

From the Coursework portlet:

1. Click the Manage Types link.

2. Click the Delete  icon beside the type you want to delete.

3. The following message appears:  "Are you sure you want to delete this item?"

4. Click OK to confirm the deletion process.

Online Assignments

Online ( ) assignments are quizzes/tests/exams created by the faculty member and which the students complete within the portlet.  These assignments are completed
and submitted by the students and can be graded automatically and/or manually by the faculty member.

Functions
Add an Online Assignment

Import Tests from File Cabinet

Edit an Assignment

View Assignment Information

View Student Assignment Detail

Show/Hide Assignment Details

Add/Remove Bonus Points

Delete Assignment

Go to Test Builder

Add an Online Assignment
The Add an Assignment screen allows a faculty member to create a new assignment.

The assignment can be created in Basic mode or in Advanced mode.  You can toggle between these two modes by using the following two links:  Show advanced set-up
options and Hide advanced set-up options.  

The following table details options available for both Basic and Advanced modes for Online assignments:

Basic Mode Advanced Mode Action
Name Name Enter the name of the assignment.
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Format Format Select the format of the assignment.
Type Type Select the type of assignment.  You can add additional types by clicking the Add an Assignment

Type link.
Required Required Select the appropriate status for the assignment:  Required (shown in Gradebook as part of final

grade), Extra Credit (optional; not part of final course grade; points earned are applied to
assignment score), Optional (not included in Gradebook).

Unit Unit Select the unit to which this assignment belongs.  You can add additional units by clicking the Add
a Unit link.

Description Description Enter the description of the assignment.  The text you enter here will display to the student.
Instructions Instructions Enter instructions for the assignment.  These instructions will appear to the student when the

assignment is active and is available to the students for completion.
  Start Even though assignments are activated from the Test Builder, you can choose to have the

assignment display while it is inactive (students cannot work on it) by selecting the Display While
Inactive check box.

  Display While Inactive Even though assignments are activated from the Test Builder, you can choose to have the
assignment display while it is inactive (students cannot work on it) by selecting this check box.

Due Due Enter or select the date and time the assignment is due.
  Allow Late Assignments Until Check this check box to allow late assignments.  Enter the date and time until which you will

accept late assignments.
  Penalize Late Assignments If you want to penalize late assignments, enter the point or percentage deduction for the late

assignment.  This can be a total penalty or assessed per day.
  Show Grade Select when you want students to be able to view their grade.
  Allow Review Select when students will be allowed to review their assignment.
  Relevant Files Select when students will be allowed to review their assignment.

 

From the Coursework portlet for the appropriate course context:

1. Click the Add an Assignment link.

2. Enter the name of the assignment.

3. Select Online  from the Format drop-down.

4. Select the appropriate assignment type from the Type drop-down.  If you need to add an assignment type, click the Add an Assignment Type link.  Once the
assignment type has been added and saved, it will be available for your selection.

5. Select the requirement status (Required, Extra Credit, or Optional) from the Required drop-down.  The default  selection is Required, which means that the
assignment will be factored into Gradebook and thus the weighted course grade.  Extra Credit means that the assignment will only benefit  the student.  Finally,
an Optional assignment is a practice quiz or test.  Its grade will not factor into the weighted averages seen in Gradebook.

6. Online assignments are always graded; therefore, when creating this type of assignment, you do not have a Grade Method option.  Point values of Online
assignments are calculated by totaling question point values.

7. Select from the Unit drop-down the unit to which you want to associate this assignment.  If you need to add a unit, click the Add a Unit link.  Once the unit has
been added and saved, it will be available for your selection.

8. Enter a Description , which is always displayed with the assignment.

9. Enter Instructions, which will display when the assignment is active.

10. Online assignments are made active from the Test Builder.  However, if you are creating the assignment in Advanced mode, you can allow the assignment to
display while it is inactive by selecting the Display While Inactive check box.

11. In the Due field, enter or select from the Calendar the due date of the assignment.  Also, select from the drop-downs the time it is due.

12. The Advanced mode allows you to let students turn in late assignments.  Due dates become "soft" due dates, and assignments can be turned in until the "hard"
due date.  Even though you allow late assignments, penalties can be assessed for the late assignments by selecting the Penalize Late Assignments check box
and entering a set point or percentage deduction.

13. The Advanced mode allows you to select from the Show Grade drop-down when you want the students to see their grades for this assignment.

14. The Advanced mode allows you to select from the Allow Review drop-down when or if you want to allow the students to review their graded assignment
including any feedback you may provide.

15. The Advanced mode displays the Relevant Files section, which allows you to upload an unlimited number of files that will be presented as part of the
assignment.  When the assignment is activated, these files are displayed below the instructions on the Assignment Info page.

16. Click the Save button.  Test Builder opens for you to create the assignment.

Import Tests from File Cabinet
From the Coursework portlet for the appropriate course context:

1. Click the Import Tests from File Cabinet link in the appropriate unit.

2. If no tests are stored in File Cabinet, the following message appears:  "No Tests found."  If tests are stored in File Cabinet, the tests are displayed.

3. Select the check box beside the test you want to import, and click the Import Selected  button.

4. Click the linked name of the assignment to go to Test Builder where you can edit the entire assignment.  

Edit an Assignment
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From the Coursework portlet for the appropriate course context:

1. Click the Edit icon beside the Online assignment you want to edit or any Edit this assignment link on the Assignment Info screen.

2. All  fields except the Format field are available for editing.

3. When you have made all  changes, click the Save button.

View Assignment Information
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Online assignment with which you want to work.  Depending on the status of the assignment, you will be directed to the Test Builder
screen or the Assignment Info screen.

2. The Assignment Info screen displays the following assignment information once it is Active:

The Header displays the type and name of assignment, unit, format, grading method, time limit, status message, and due date information.  A message
indicating number of tests that need grading and the number of students who have not yet taken the test may also display.

The following links are available for you to work with the assignment:  Show assignment details, Edit this assignment, Delete this assignment, and Go to
Test Builder.

The Student Results  table lists the students in the course with each name linked to their respective Student Assignment Detail screen.  You can sort
the list by Student, Date Finalized, and Grade (click the respective link).  This table also provides you with information on how much time each student
spent completing the assignment and whether the assignment needs manual grading (indicated by the ! icon).

Bonus Points can be added or removed.

View Student Assignment Detail
If an Online assignment is active, you can view details of students' responses.

From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Online assignment with which you want to work.

2. On the Assignment Info screen, click the name of the student whose assignment detail you want to view.

3. The Student Assignment Detail screen displays the following information for that student:

The Header displays the type and name of assignment, unit, format, grading method, time limit, status message, and due date information.  A message indicating
number of tests that need grading and the number of students who have not yet taken the test may also display.

If appropriate, the Workflow table for this assignment will display the life cycle of the assignment.

The Individual Results  table will always display each attempt and its completion date, score, time spent, and status.  A Review link may be available for you to
review the assignment.

The Extension table is available if the assignment is still open.  This table allows you to extend the due date of the assignment for that specific student, not the
entire class.

The Results  table allows you to see the base score, any bonus points, and the final score; assess any late penalty (Change Penalty link) or make other
adjustments (Change Adjustment/Feedback link); and add or edit a personalized note or feedback (Change Adjustment/Feedback link).

If the assignment is still open (for example, student has not taken the test, has not completed all  attempts, or has not marked the test as finalized), a Close
Assignment button is available for the instructor to automatically close the assignment and optionally enter a reason for closing.

The Retake table allows you to reopen an assignment or give the student permission to retake the assignment.  A retake allows the student to do the entire
assignment including all  attempts.  The final grade can be determined by using the retake final grade, averaging the original and retake final grades, or using the
highest final grade (whether it be the original or retake).  The due date for a retake will be on an individual student basis.  When all  decisions have been entered,
click the Allow Retake button.

Show/Hide Assignment Details
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Online assignment with which you want to work.

2. Clicking the Show Assignment Details/Hide Assignment Details links allows you to view or hide the Description , Instructions, and Files attached to the
assignment.

Add/Remove Bonus Points
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Online assignment to which you want to add/remove bonus points.

2. To add bonus points:  In the Bonus  section at the bottom of the Assignment Info screen, enter in the Bonus Points text box the number of points you want to
add to the grade of all  students who complete the assignment.  Click the Add the Bonus  button.

3. To remove bonus points:  In the Bonus  section at the bottom of the Assignment Info screen, click the Remove the bonus link and then clear the Bonus Points
text box.

Delete Assignment
From the Coursework portlet for the appropriate course context:

1. Click the Delete  icon beside the Online assignment you want to delete or any Delete this assignment link.



Coursework for Faculty

https://my.mineralarea.edu/ics/Help/LMS/coursework_for_faculty.htm[3/1/2010 7:33:53 PM]

2. The following message appears:  "Are you sure you want to delete this item?"

3. Click the OK button to confirm the delete process.

Go to Test Builder
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Online assignment with which you want to work.

2. On the Assignment Info screen, click the Go to Test Builder link.

3. Test Builder opens and allows you to work with this Online assignment.

Test Builder
Adding and saving an Online assignment opens the Test Builder screen, which is used by the instructor to build and manage Online assignments (quizzes, tests, exams,
etc.).  

The Main screen has four areas:

Header

Activation

Add Questions

Sections

Header
The Header displays the assignment name, the unit, format, and grading method entered when you created the assignment.  This information can be edited by clicking the
Edit this assignment link at the right side of the Header.  The number of questions and the point total are also displayed.  If the assignment is Active,  the View assignment
info link is available.

Configurations can be set for each Online assignment.  The right side of the Header allows the instructor to hide (Hide settings) or display (Show settings), and edit (Edit
settings) these settings.

Activation
The Activation Bar displays the status of the test (Active/Inactive).

In order for you to activate an assignment, it must have at least one question in a non-extra credit section and all  questions must have point values.

The following table details links that are available for both Active and Inactive assignments:

Available Link/Functionality Active Status Inactive Status
Edit this assignment X X
View assignment info X  
Show settings X X
Hide settings X X
Edit settings X X
Set a future activation date   X
Preview this test X X
Import questions from your File Cabinet   X
Save to File Cabinet X  
Add a Section   X
Reorder Sections   X
Edit Section X X
Delete Section   X
Add Questions X  
Edit All  Questions   X
Edit Question Point Values   X
Reorder/Move Questions   X

 

Add Questions
The Add Questions area allows the faculty member to add questions to the test by choosing a question type, number of questions to add, and the section to which they
are to be added.  Any total number of questions can be added, but only a maximum of five at a time.  Also, only one type of question can be added at a time and to only
one section at a time.

The Add button opens the Add Questions page.

If you have questions stored in File Cabinet, you can also add questions to your assignment via the Import questions from your File Cabinet link.

Sections

https://my.mineralarea.edu/ics/Help/LMS/file_cabinet.htm
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A section is a method of organizing questions within tests.  Every test must have at least one section, and every question must be in one and only one section.  There can
be unlimited sections in a test and unlimited questions in a section.

The Sections area displays all  sections of the test and all  questions within the sections.  You can add a section, edit a section, delete a section, and reorder sections by
clicking the appropriate links. There are two types of sections:

Regular sections have no special functions.  All  questions are presented in the test, and each question has its own point value.

Question Pool sections randomly select a preset number of questions from all  the questions in the section when the student attempts the test.  Each question has
a set point value so that the section is worth the same number of points regardless of which questions are randomly selected.

Functions
Functions include the following:

Edit Assignments

Show/Hide/Edit Settings

Add a Test Section

Edit Question Point Values

Edit Questions in a Section

Reorder/Move Questions in a Section

Edit Sections

Reorder Sections

Delete Sections

Add Questions

Activate/Deactivate Tests

Preview a Test

Save Tests to File Cabinet

Import Questions from File Cabinet

Edit Assignments
1. From the Test Builder portlet, click the Edit this assignment link to view and edit the basic setup options.

2. To view all  assignment options available, click the Show advanced setup options link.

3. Select or enter values in all  fields except Format.

4. Click the Save button.

Show/Hide/Edit Settings
Unique configurations for each Online assignment can be set.  The right side of the Header allows you to hide (Hide settings link), display (Show settings link), and edit
(Edit settings link) the following settings:

Time Limit

Attempts Allowed

Final Grade

Pagination

Section Order

Lock Out

Extra Credit

Add a Test Section
Sections are used to organize and group questions in a test.  Every online assignment must have at least one section, and every question must be in one and only one
section.  There can be unlimited sections in a test and unlimited questions in a section.  In addition to adding test sections, sections can be edited and reordered.

The Add a Section link opens the Add a Section  page in Test Builder.  The following fields are available for defining a test section:

Name

Position

Source Material

Section Type
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Extra Credit

Randomize

Edit Question Point Values
When you import questions from File Cabinet, point values (if set) also import with the questions; however, they can be changed but only in an Inactive test.

1. In the Coursework portlet, click the name of the test for which you want to change point values.

2. From Test Builder, click the Edit Question Point Values link in the Sections area.

3. Edit point values.

4. Click the Save button.

Edit Questions in a Section
Questions can only be edited in an Inactive test.

1. In the Coursework portlet, click the name of the assignment for which you want to edit questions.

2. From Test Builder, click the Edit All  Questions link in the Sections area.

3. Make necessary edits.

4. Click the Save button.

Reorder/Move Questions in a Section
Questions in a section can only be reordered/moved in an Inactive test.

1. In the Coursework portlet, click the name of the assignment for which you want to reorder questions.

2. From Test Builder, click the Reorder/Move All  Questions link in the Sections area.

3. To reorder the questions, enter the appropriate numerical value in the text box beside the question and click the Save button.

4. To move the questions, select the appropriate questions to move and then select the appropriate section to which to move them in the Move selected to drop-
down and click the Go button.

5. You can also edit and delete questions on this screen.

Edit Sections
The Edit Section link for any test section opens the Edit Section  screen in Test Builder.

If the assignment is Inactive, all  fields are available for editing.

If the assignment is Active,  all  fields except Source Type and Extra Credit can be edited.

Reorder Sections
Test Sections can be reordered in a test that is not activated.

The Reorder Sections link for any test opens the Order Sections screen in Test Builder.  All  sections of the test are listed.  To reorder,  enter the appropriate number in
the text box beside each section.  The options to edit or delete the section are also available on this screen.

Delete Sections
Test Sections can be deleted in a test that is not activated.

The Delete Section link for any test section prompts you with a confirmation message:  "Are you sure you want to delete this item?"  If you click the Yes button, the entire
section (including any questions in the section) is deleted.

Add Questions
Instructors can add questions to a test by choosing a question type, number of questions to add, and the section to which they are to be added.  Only one type of question
can be added at a time and to only one section at a time.  You can also add questions by importing stored questions from your File Cabinet.  After selecting the question
type, the number of questions to add, and the unit to which to add them, click the Add button to open the Add Questions screen.  Questions can only be added to
Inactive online assignments.

Six types of questions can be added to tests:

Multiple Choice/Answer

True/False

Essay

Short Answer

Ordering

Matching

Multiple Choice/Answer
This type of question has several answer options, one or more of which is required to be selected as a correct answer.   The answer options can be presented in a set
order or randomized for each student taking the test, but there must be at least one option and one correct answer identified.  Any question or answer options left blank
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will be ignored.  Also, if you need more answer options, the Add more answers link provides you with additional answer fields.  Each answer option can also include
feedback that displays when the student reviews the test.  

Partial credit for a question can be given if the student is informed of how many correct answers there are and then limit the student to selecting only that many answers.  

If used, Automatic Feedback text can appear under the following three circumstances:

Regardless of whether the answer is correct or incorrect (general)

When a correct answer is selected

When an incorrect answer is selected

This text is displayed during the student's review of the graded test.

1. In the Add Questions section of Test Builder, select Multiple Choice/Answer in the Question Type drop-down list box.

2. Select the Number of Questions from the drop-down list box.  1, 2, 3, 4, 5 are the only options. You cannot enter any other number.

3. From the Add to Section  drop-down, select the section to which to add these questions.

4. Click the Add button to open the next page in Test Builder.

5. Enter the test question in the Question Text box.

6. Enter possible answers in the Answer Text boxes (one answer per box).  If you want to add more answers,  click the Add more answers link.

7. Select the check box(es) beside the correct answer(s).

8. You can enter feedback text for each answer.

9. Select the Randomize check box if you want the answers to be randomly re-ordered each time is test is taken.  If you do not select this check box, the answers
will be presented in the order you entered them.

10. Select the Partial Credit check box if there are multiple answers and you want to give credit for any correct answer selected.

11. Click the Add automatic feedback link to enter text you want the students to see during their review of the test.  Text entered as General Info will always be seen
by the student, On Correct Answer  text will be seen when a correct answer has been given, and On Incorrect Answer  text will be seen when an incorrect
answer has been given.

12. The Next Step includes two options:  

If you have completed entering questions, click the Save button to return to the main page of Test Builder.

If you have additional questions to add to the test, use the Add More Questions option.  Select the question type, number of questions, and the section
to which to add the questions.  Click the Save These and Add More button.  Continue until all  questions have been entered, at which time you can click
the Save button to return to the main page of Test Builder.

True/False
This type of question is answered by selecting True or False.

1. In the Add Questions section of Test Builder, select True/False  from the Question Type drop-down.

2. Select the Number of Questions from the drop-down.  1, 2, 3, 4, 5 are the only options--you cannot enter any other number.

3. From the Add to Section  drop-down, select the section to which to add these questions.

4. Click the Add button to open the next page in Test Builder.

5. Enter the test question in the Question Text box.

6. Select the appropriate answer radio button:  True or False.

7. Click the Add automatic feedback link  to enter text you want to the student to see during their review of the test.  Text entered as General Info will always be
seen by the student, On Correct Answer  text will be seen when a correct answer has been given, and On Incorrect Answer  text will be seen when an incorrect
answer has been given.

8. The Next Step includes two options:  

If you have completed entering questions, click the Save button to return to the main page of Test Builder.

If you have additional questions to add to the test, use the Add More Questions option.  Select the question type, number of questions, and the section
to which to add the questions.  Click the Save These and Add More button.  Continue until all  questions have been entered, at which time you will click
the Save button to return to the main page of Test Builder.

Essay
Essay questions require that students enter a free-form answer.

NOTE:  Essay questions must be graded manually by the instructor before a grade can be given for the test.

1. In the Add Questions section of Test Builder, select Essay in the Question Type drop-down.

2. Select the Number of Questions from the drop-down.  1, 2, 3, 4, 5 are the only options--you cannot enter any other number.
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3. From the Add to Section  drop-down, select the section to which to add these questions.

4. Click the Add button to open the next page in Test Builder.

5. Enter the test question in the Question Text box.

6. The Next Step includes two options:  

If you have completed entering questions, click the Save button to return to the main page of Test Builder.

If you have additional questions to add to the test, use the Add More Questions option.  Select the question type, number of questions, and the section
to which to add the questions.  Click the Save These and Add More button.  Continue until all  questions have been entered, at which time you will click
the Save button to return to the main page of Test Builder.

Short Answer
Short Answer questions are answered by the student in an open format like a shorter essay question that will be graded manually by the instructor or a more specific and
most likely shorter answer that will be graded automatically based on whether the given answer matches EXACTLY (not case-sensitive) the defined correct answer.   

Automatically graded Short Answer questions are best suited for number-based answers and for spelling or terminology testing.

1. In the Add Questions section of Test Builder, select Short Answer  in the Question Type drop-down.

2. Select the Number of Questions from the drop-down.  1, 2, 3, 4, 5 are the only options--you cannot enter any other number.

3. From the Add to Section  drop-down, select the section to which to add these questions.

4. Click the Add button to open the next page in Test Builder.

5. Enter the test question in the Question Text box.

6. Select the appropriate answer radio button:  Graded manually or Graded automatically.  The Graded automatically option requires that you enter answer text
that will serve as an EXACT MATCH during the automatic grading process.  This exact match is not case-sensitive.

7. If you selected the Graded automatically option, the Add automatic feedback link is available for you to enter text you want the students to see during their
review of the test.  Text entered as General Info will always be seen by the student, On Correct Answer  text will be seen when a correct answer has been
given, and On Incorrect Answer  text will be seen when an incorrect answer has been given.

8. The Next Step includes two options:  

If you have completed entering questions, click the Save button to return to the main page of Test Builder.

If you have additional questions to add to the test, use the Add More Questions option.  Select the question type, number of questions, and the section
to which to add the questions.  Click the Save These and Add More button.  Continue until all  questions have been entered, at which time you will click
the Save button to return to the main page of Test Builder.

Ordering
An ordering question requires that the students put randomized answers in the correct order.  Each ordering question must have at least two answer options to order.

Any question or answer options left blank will be ignored.  Also, if you need more item options, the Add more items link provides you with additional fields.

Automatic Feedback can be entered (Add automatic feedback link) to provide the student further information when reviewing the graded test.

1. In the Add Questions section of Test Builder, select Ordering in the Question Type drop-down.

2. Select the Number of Questions from the drop-down.  1, 2, 3, 4, 5 are the only options--you cannot enter any other number.

3. From the Add to Section  drop-down, select the section to which to add these questions.

4. Click the Add button to open the next page in Test Builder.

5. Enter the test question in the Question Text box.

6. In the Answer Text box, enter the answers in the correct order.

7. Click the Add automatic feedback link to enter text you want to students to see during their review of the test.  Text entered as General Info will always be seen
by the student, On Correct Answer  text will be seen when a correct answer has been given, and On Incorrect Answer  text will be seen when an incorrect
answer has been given.

8. The Next Step includes two options:  

If you have completed entering questions, click the Save button to return to the main page of Test Builder.

If you have additional questions to add to the test, use the Add More Questions option.  Select the question type, number of questions, and the section
to which to add the questions.  Click the Save These and Add More button.  Continue until all  questions have been entered, at which time you will click
the Save button to return to the main page of Test Builder.

Matching
Matching questions require that students match an object with its correct answer option.  Matching questions must have at least two answer options.  Unmatched answer
options can also be included and will be randomly mixed with the matched answer options.

Any question or answer options left blank will be ignored.  Also, if you need more fields for matched objects or unmatched objects, the Add more objects and Add more
unmatched objects links provide you with additional fields.

Automatic Feedback can be entered (Add automatic feedback link) to provide students with further information when reviewing the graded test.
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1. In the Add Questions section of Test Builder, select Matching in the Question Type drop-down.

2. Select the Number of Questions from the drop-down.  1, 2, 3, 4, 5 are the only options--you cannot enter any other number.

3. From the Add to Section  drop-down, select the section to which to add these questions.

4. Click the Add button to open the next page in Test Builder.

5. Enter the test question in the Question Text box.

6. In the Answer  section, enter the objects and their correct matches.  You can also enter some incorrect matches for a higher level of difficulty.

7. Click the Add automatic feedback link to enter text you want students to see during their review of the test.  Text entered as General Info will always be seen by
the student, On Correct Answer  text will be seen when a correct answer has been given, and On Incorrect Answer  text will be seen when an incorrect answer
has been given.

8. The Next Step includes two options:  

If you have completed entering questions, click the Save button to return to the main page of Test Builder.

If you have additional questions to add to the test, use the Add More Questions option.  Select the question type, number of questions, and the section
to which to add the questions.  Click the Save These and Add More button.  Continue until all  questions have been entered, at which time you will click
the Save button to return to the main page of Test Builder.

Activate/Deactivate Tests
The Activation Bar displays the status of the test (Active/Inactive).

Students cannot take an Inactive test and possibly not see an Inactive test, but an Inactive test can be edited by the faculty member.  To activate a test, it must have at
least one question in a non-extra credit section and all  questions must have point values.  The Set a future activation date link is also available and will activate the
assignment automatically on the date/time you set.

Students can take an Active test as soon as it is activated.  Some selected parts can still be edited by the instructor.

For more information, see Activation.

Preview a Test
The Preview this test link allows the faculty member to view/take the test as if they were a student.

Save Tests to File Cabinet
If you want to save the test to your File Cabinet for future use, use the Save to File Cabinet link, which becomes available once the test is activated.

When you click the link, a Confirmation screen confirms that the test has been saved and allows you to return to Coursework.

Import Questions from File Cabinet
You can also add questions to your tests by importing saved questions from your File Cabinet (Import Questions from your File Cabinet link).

1. From the main Test Builder page, click the Import Questions from your File Cabinet link.  This link is available if you have stored tests in File Cabinet.

2. You can search for questions and/or answers,  and you can view test sections in order to determine the questions you want to import.

Search for Questions: Clicking this link allows you to search by type and also to search for questions only or questions and answers.   

Search criteria are not case-sensitive. When you set your search criteria (or you can leave it blank) and click the Search button, Search Results
displays each question matching your criteria and the type and location of the question.  If you do not get the desired results or wish to conduct another
search, enter new criteria and click the Search Again button.

Select the check box beside the question(s) you want to import, select the assignment to which you want to import these questions, and click the Import
Selected  button. The questions are then imported into the desired test.

View Sections:

1. Click the Import Questions from your File Cabinet link.

2. Click the appropriate Coursework folder.

3. Click the appropriate View Sections link.

4. You can import an entire section (including questions in the section) by selecting the check box beside a section and then clicking the Import
Selected  button.

5. You can click the section names, which display individual questions in that section, to display questions in that section.  All  questions can be
selected or individual questions can be selected for importing.

File Exchange Assignments
File Exchange ( ) assignments involve receiving and downloading files submitted by the students.  You can upload a file to be used by the student for directions or
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other reasons.  Once you receive their file, you can send it back to the students.  An example of a File Exchange assignment is a paper.

Functions include the following:

Add a File Exchange Assignment

Edit an Assignment

View Assignment Information

View Submitted Student Files

Enter Grades

Re-enter Grade/Feedback

Reopen Assignment

Show/Hide Assignment Details

Add/Remove Bonus Points

Delete Assignments

Add a File Exchange Assignment
The Add an Assignment screen allows a faculty member to create a new assignment.  The assignment can be created in Basic mode or in Advanced mode.  You can
toggle between these two modes by using the following two links:  Show advanced set-up options and Hide advanced set-up options.  

The following table details options available for both Basic and Advanced modes for File Exchange assignments:

Basic Mode Advanced Mode Action
Name Name Enter the name of the assignment.
Format Format Select the format of the assignment.
Type Type Select the type of assignment.  You can add additional types by clicking the Add an Assignment Type link.
Required Required Select the appropriate status for the assignment:  Required (shown in Gradebook as part of final grade),

Extra Credit (optional; not part of final course grade; points earned are applied to assignment score),
Optional (not included in Gradebook).

Grade Method Grade Method Select the appropriate grade method for this assignment:  Not Graded (no grade given);  Credit/No Credit
(credit or no credit will be given upon completion); Graded (graded based on maximum  points entered in
the Out of points field)

Unit Unit Select the unit to which this assignment belongs.  You can add additional units by clicking the Add a Unit
link.

Description Description Enter the description of the assignment.  The text you enter here will display to the student.
Instructions Instructions Enter instructions for the assignment.  These instructions will display to the student when the assignment is

active and is available to the students for completion.
  Start Even though assignments are activated from the Test Builder, you can choose to have the assignment

display while it is inactive (students cannot work on it) by selecting the Display While Inactive check box.
  Display While Inactive Even though assignments are activated from the Test Builder, you can choose to have the assignment

display while it is inactive (students cannot work on it) by selecting this check box.
Due Due Enter or select the date and time the assignment is due.
  Allow Late Assignments Until Check this check box to allow late assignments.  Enter the date and time until which you will accept late

assignments.
  Penalize Late Assignments If you want to penalize late assignments, enter the point or percentage deduction for the late assignment.

 This can be a total penalty or assessed per day.
  Show Grade Select when you want students to be able to view their grade.
  Relevant Files This section allows you to upload relevant assignment files

 

From the Coursework portlet for the appropriate course context:

1. Click the Add an Assignment link.

2. Enter the name of the assignment.

3. Select File Exchange from the Format drop-down.

4. Select the appropriate assignment type from the Type drop-down.  If you need to add an assignment type, click the Add an Assignment Type link.  Once the
assignment type has been added and saved, it will be available for your selection.

5. Select the requirement status from the Required drop-down.

6. Select from the Grade Method drop-down the grading method you will use for this assignment.  The Grade Method for File Exchange assignments can be Not
Graded , Credit/No Credit, or Graded .

7. If an assignment is graded, you must enter the maximum number of points for the assignment in the Out of field. This point value is not related to the weight of
the assignment, unless you are using the Basic mode in Gradebook.  The Gradebook is used to manage relative weights of assignments in determining the final
grade.

8. Select from the Unit drop-down the unit to which you want to associate this assignment.  If you need to add a unit, click the Add a Unit link.  Once the unit has
been added and saved, it will be available for your selection.

https://my.mineralarea.edu/ics/Help/LMS/gradebook_portlet.htm
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9. Enter a Description , which is always displayed with the assignment.

10. Enter Instructions, which will display when the assignment is active.

11. In the Due field, enter or select from the Calendar the due date of the assignment.  Also, select from the drop-down list boxes the time it is due.

12. The Advanced mode allows you to determine when the assignment is activated by selecting a Start option:  Activate Now , Activate Later Manually, or Active
From.   If you select the Active From option, you must also select the appropriate date and time.  If you want an inactive assignment to be visible to students,
select the Display While Inactive check box.  

13. Select the Due date and time from the calendar and time drop-down list boxes.  The Advanced mode allows you to allow students to turn in late assignments by
selecting the Allow Late Assignments Until check box and then selecting the deadline for the late assignment.  Due dates become "soft" due dates, and
assignments can be turned in until the "hard" due date.  Even though you allow late assignments, penalties can be assessed for the late assignments by
selecting the Penalize Late Assignments check box and entering a set point or percentage deduction.

14. The Advanced mode includes a Show Grade option, which sets when students can see their grade.  Select the appropriate option from the Show Grade drop-
down list box.

15. The Advanced mode displays the Relevant Files section, which allows you to upload an unlimited number of files that will be presented as part of the
assignment.  When the assignment is activated, these files are displayed below the instructions on the Assignment Info page.

16. Click the Save button.

Edit an Assignment
From the Coursework portlet for the appropriate course context:

1. Click the Edit icon beside the File Exchange assignment you want to edit or click the Edit this assignment link from the Assignment Info screen.

2. All  fields except the Format and Grade Method fields are available for editing.

3. When you have made all  changes, click the Save button.

View Assignment Information
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment you want to work with.

2. The Assignment Info screen displays the following assignment information:

The Header displays the type and name of assignment, unit, format, grading method, status message, and due date information.

Links are available for you to work with the assignment (Show/Hide assignment details, Edit this assignment, Delete this Assignment).

The Student Results  table lists the students in the course and allows you to enter their grades and any comments for feedback.  You can sort the list
by Student, Date Finalized, and Grade (click the respective link).  The ! column informs you of ungraded submitted assignments.

Bonus Points can be added or removed using the Bonus  table.

View Submitted Student Files
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment for which you want to enter grades.

2. On the Assignment Info screen, click the linked name of the student for which you want to enter a grade

3. The Student Assignment Details screen displays assignment information, including the Files Submitted table showing the files uploaded by the student if the
assignment has been finalized.  The table is empty if the student has not submitted and finalized the assignment.

Enter Grades
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment for which you want to enter grades.

2. On the Assignment Info screen, click the linked name of the student for which you want to enter a grade

3. The Student Assignment Details screen displays the following assignment information:

The Workflow table is always displayed.  This table details the life cycle of the assignment.

The Results  table displays currently entered grade and feedback information or provides fields to enter both.  You can also upload files to be returned to
the student when the grade is displayed.  If the assignment has not been submitted by the student, a Close Assignment button is available for you to
close the assignment and enter a reason for the closure.

The Reopen Assignment table allows you to extend the due date of the assignment.  If the assignment has been finalized, you can re-open the
assignment with or without an extension.  For example, you may want to re-open an assignment because a student may have inadvertently submitted an
incomplete assignment.
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If a student has not completed an assignment, you can grant an extension by using the Extension table.

1. If desired, enter free-form text in the Note field.

2. In the New Due Date field, select the new date from the calendar.

3. Select the times for the new deadline from the drop-down list boxes.

4. Click the Grant Extension button.

5. The Workflow table will reflect the extended deadline.

4. In the Results  table, enter the grade in the Grade field.

5. Enter any comments in the Feedback  field.

6. Browse for any file you wish to upload for the student.

7. Click the Save button.

Re-enter Grade/Feedback
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment you want to reopen.

2. On the Assignment Info screen, click the linked name of the student for which you want to reopen an assignment.

3. The Student Assignment Details screen displays assignment information, including the Results  table, showing currently entered grade information or providing
fields to enter grade information.  You can also upload files to be returned to the student when the grade is displayed.

4. In the Results table, click the Re-enter grade/feedback link.

5. Make edits.

6. Click the Save button.

Reopen Assignment
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment you want to reopen.

2. On the Assignment Info screen, click the linked name of the student for which you want to reopen an assignment.

3. The Assignment Details screen displays assignment information, including the Reopen Assignment table, allowing you to extend the due date of any
assignment.  If the assignment has been finalized, you can re-open the assignment with or without an extension.  For example, you may want to re-open an
assignment because a student may have inadvertently submitted an incomplete assignment.

4. In the Reopen Assignment table, enter any desired text in the Note field.

5. Click the radio button beside the field that allows you to enter an extension date.  Enter or select the appropriate date by using the Calendar icon.

6. Select the extension deadline time from the drop-down list boxes.

7. Click the Reopen button.

Show/Hide Assignment Details
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment you want to work with.

2. Clicking the Show Assignment Details/Hide Assignment Details links allows you to view or hide the Description , Instructions, and Files attached to the
assignment.

Add/Remove Bonus Points
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the File Exchange assignment to which you want to add/remove bonus points.

2. To add bonus points:  In the Bonus  section at the bottom of the Assignment Info screen, enter in the Bonus Points text box the number of points you want to
add to the grade of all  students who complete the assignment.  Click the Add the Bonus  button.

3. To remove bonus points:  In the Bonus  section at the bottom of the Assignment Info screen, click the Remove the bonus link and then clear the Bonus Points
text box.

Delete Assignments
From the Coursework portlet for the appropriate course context:
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1. Click the Delete  icon beside the File Exchange assignment you want to delete or click any Delete this assignment link.

2. The following message appears:  "Are you sure you want to delete this item?"

3. Click the OK button to confirm the delete process.

Offline Assignments
Offline ( ) assignments have no online component.  They are listed within the portlet and graded within the portlet and are incorporated into Gradebook, but they are
completed offline.  Examples of offline assignments are going on a field trip, delivering an oral presentation, viewing a video, or attending a lecture.

Functions include the following:

Add an Offline Assignment

Edit an Assignment

View Assignment Information

Enter Grades

Re-enter Grade/Feedback

Show/Hide Assignment Details

Add/Remove Bonus Points

Delete Assignment

Add an Offline Assignment
The Add an Assignment screen allows a faculty member to create a new assignment.  The assignment can be created in Basic mode or in Advanced mode.  You can
toggle between these two modes by using the following two links:  Show advanced set-up options and Hide advanced set-up options.  

The following table details options available for both Basic and Advanced modes for Offline assignments:

Basic Mode Advanced Mode Action
Name Name Enter the name of the assignment.

Format Format Select the format of the assignment.

Type Type Select the type of assignment.  You can add additional types by clicking the Add an Assignment
Type link.

Required Required Select the appropriate status for the assignment:  Required (shown in Gradebook as part of final
grade), Extra Credit (optional; not part of final course grade; points earned are applied to
assignment score), Optional (not included in Gradebook).

Grade Method Grade Method Select the appropriate grade method for this assignment:  Not Graded (no grade given);  Credit/No
Credit (credit or no credit will be given upon completion); Graded (graded based on maximum  points
entered in the Out of points field)

Unit Unit Select the unit to which this assignment belongs.  You can add additional units by clicking the Add a
Unit link.

Description Description Enter the description of the assignment.  The text you enter here will display to the student.

Instructions Instructions Enter instructions for the assignment.  These instructions will display to the student when the
assignment is active and is available to the students for completion.

Due Due Enter or select the date and time the assignment is due.

  Relevant Files This section allows you to upload relevant assignment files

 

From the Coursework portlet for the appropriate course context:

1. Click the Add an Assignment link.

2. Enter the name of the assignment.

3. Select Offline from the Format drop-down.

4. Select the appropriate assignment type from the Type drop-down.  If you need to add an assignment type, click the Add an Assignment Type link.  Once the
assignment type has been added and saved, it will be available for your selection.

5. Select the requirement status from the Required drop-down.
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6. Select from the Grade Method drop-down the grading method you will use for this assignment.  The Grade Method for Offline assignments can be Not Graded ,
Credit/No Credit, or Graded .

7. If an assignment is graded, you must enter the maximum number of points for the assignment in the Out of field. This point value is not related to the weight of
the assignment, unless the Basic mode is selected for Gradebook.  The Gradebook is used to manage relative weights of assignments in determining the final
grade.

8. Select from the Unit drop-down the unit to which you want to associate this assignment.  If you need to add a unit, click the Add a Unit link.  Once the unit has
been added and saved, it will be available for your selection.

9. Enter a Description , which is always displayed with the assignment.

10. Enter Instructions, which will display when the assignment is active.

11. In the Due field, enter or select from the Calendar the due date of the assignment.  Also, select from the drop-downs the time it is due.

12. The Advanced mode displays the Relevant Files section, which allows you to upload an unlimited number of files that will be presented as part of the
assignment.  When the assignment is activated, these files are displayed below the instructions on the Assignment Info page.

13. Click the Save button.

Edit an Assignment
From the Coursework portlet for the appropriate course context:

1. Click the Edit icon beside the Offline assignment you want to edit or click the Edit this assignment link on the Assignment Info screen.

2. All  fields except the Format and Grade Method fields are available for editing.

3. When you have made all  changes, click the Save button.

View Assignment Information
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Offline assignment you want to work with.

2. The Assignment Info screen displays the following assignment information:

The Header displays the type and name of assignment, unit, format, grading method, status message, and due date information.

Links are available for you to work with the assignment.

The Assignment Stats section displays a breakdown of grade distribution.

The Student Results  table lists the students in the course and allows you to enter their grades and any comments for feedback.  You can sort the list
by Student, Grade, and Feedback (click the respective link).  

Bonus Points can be added or removed.

Enter Grades
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Offline assignment for which you want to enter grades.

2. The Assignment Info screen displays the assignment information, including the Student Results  table, which provides fields to enter grade information and/or
feedback.

3. In the Results  table, enter the grade in the Grade field.

4. Enter any comments in the Feedback  field.

5. Click the Save button.

Re-enter Grade/Feedback
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Offline assignment you want to reopen.

2. The Assignment Info screen displays assignment information, including the Student Results  table, which displays currently entered grade information or
provides fields to enter grade information and/or feedback.

3. In the Results table, click the Edit graded entries link.

4. Make edits.

5. Click the Save button.

https://my.mineralarea.edu/ics/Help/LMS/gradebook_portlet.htm
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Show/Hide Assignment Details
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Offline assignment you want to work with.

2. Clicking the Show Assignment Details/Hide Assignment Details links allows you to view or hide the Description , Instructions, and Files attached to the
assignment.

Add/Remove Bonus Points
From the Coursework portlet for the appropriate course context:

1. Click the linked name of the Offline assignment to which you want to add/remove bonus points.

2. To add bonus points:  In the Bonus  section at the bottom of the Assignment Info screen, enter in the Bonus Points text box the number of points you want to
add to the grade of all  students who complete the assignment.  Click the Add the Bonus  button.

3. To remove bonus points:  In the Bonus  section at the bottom of the Assignment Info screen, click the Remove the bonus link and then clear the Bonus Points
text box.

Delete Assignment
From the Coursework portlet for the appropriate course context:

1. Click the Delete  icon beside the Offline assignment you want to delete or click any Delete this assignment link.

2. The following message appears:  "Are you sure you want to delete this item?"

3. Click the OK button to confirm the delete process.
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